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Introduction

Sound diffusers are objects or surfaces that are designed to reflect incident sound energy 
evenly across angles. They are widely used in room acoustics as a way to influence the 
spatial distribution of the sound field without necessarily attenuating it. One common type 
of diffuser is the Schroeder diffuser, also called well-based diffuser, which consists of a 
series of wells of different depths. The depths are determined from a mathematical 
sequence, such as quadratic residue or primitive root. The principle behind this type of 
diffuser is that each well will re-emit the incident wave with a different phase shift, causing 
interferences between the waves emitted by the different wells. The mathematical 
sequence used to determine the depths of the wells will then dictate the interference 
pattern and, hence, the polar response of the diffuser.

This model demonstrates how to calculate the scattering coefficient with the Pressure 
Acoustics, Frequency Domain interface. This coefficient is one of the main inputs for 
expressing boundary conditions in typical room acoustic simulations. Its measurement 
procedure can be complicated to set up. Therefore. it is more efficient to determine the 
data numerically. In addition, the effect of periodicity is investigated by studying the 
responses from different arrangements of the same diffuser.

Model Definition

The model represents a primitive root diffuser, a type of Schroeder diffuser which aims at 
eliminating the specular component in the reflected energy polar response (see Ref. 1). 
The model at hand is based on the primitive root sequence with 7 as odd prime, resulting 
in a diffuser with 6 wells. The study is carried out in 2D in order to considerably reduce 
the number of degrees of freedom in the simulation. Three cases are taken into account as 
shown in Figure 1:

• Asingle diffuser flushed in an infinite baffle

• An arrangement of 5 diffusers adjacent to each other flushed in an infinite baffle

• An infinite arrangement of diffusers (a single unit cell is shown)

In the first two cases, a semicircle with radius r0 = 10 m is added to act as an integration 
line in the far field. The diffusers are surrounded by an air domain terminated by a Perfectly 

Matched Boundary, and the sound field outside of the calculation domain is obtained from 
Exterior Field Calculation. In the case of the infinite arrangement, Periodic Condition>Floquet 

periodicity is used to virtually extend the domain in both directions along the x-axis.
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A plane wave with incidence angle θ0 from the y-axis is defined as incoming on the diffuser 
arrangements. When present, the specular reflection from the infinite baffle is also 
included in the Background Pressure Field; this allows the solver to only compute the effect 
of the diffuser relative to the ideal sound field from a single infinite baffle. The incidence 
angle is varied in an Auxiliary Sweep from θ0 = −80° to θ0 = 80° with an increment of 10°, 
resulting in 17 incidence angles. Octave bands from 125 Hz to 4000 Hz are taken into 
account with 6 frequencies per band by setting up a Parametric Sweep on the band number 
parameter n.

Figure 1: Geometries of the diffuser arrangements. Top left: single diffuser; Top right: 5-unit 
arrangement; Bottom: infinite arrangement.

S C A T T E R I N G  C O E F F I C I E N T

The scattering coefficient s is defined as the power ratio (see Ref. 1)

 (1)

with Pspec the power reflected in the specular direction and Ptot the total reflected power. 
In this model, power is calculated by evaluating sound intensity on a semicircle Ω with 

s 1
Pspec
Ptot
------------–=
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radius r0 located in the far field. After defining the reflected sound pressure pr, the total 
power is obtained from the line integral (see Ref. 2, 3)

 (2)

This quantity can be evaluated directly with Component 1>Definitions>Nonlocal Couplings>

Integration. For the specular power, sound intensity is integrated over a fraction of the 
semicircle centered around the specular direction θs. With ε an angular increment, the 
integration arc is defined as Γ: . This leads to

 (3)

 (4)

When ε tends to zero, the integral becomes

 (5)

With δ the delta function. From convolving the absolute squared pressure with the delta 
function, it follows that the power reflected in the specular direction can be evaluated as

 (6)

Recalling Equation 1, the scattering coefficient can then be expressed as

 (7)

For the infinite arrangement, it is not possible to define a semicircle that would encompass 
the whole geometry. The scattering coefficient is therefore based on its intensity definition

 (8)
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with Ispec the reflected intensity magnitude in the specular direction and Itot the total 
reflected intensity magnitude. The reflected intensity Ir can be obtained in the model by 
checking the box Pressure Acoustics, Frequency Domain>Background Pressure Field>Calculate 

background and scattered field intensity. The specular magnitude can then be calculated by 
taking the dot product with the specular direction unit vector es, and the total magnitude 
is a straightforward calculation. However, since the geometry is infinite, every point on the 
x-axis is a valid option as the origin for the unit vector. Therefore, the values are integrated 
over the top boundary L of the domain to give the scattering coefficient

 (9)

The coefficient in Equation 7 or Equation 9 gives a value for each incidence angle and 
frequency included in the study. To obtain the random incidence scattering coefficient in 
octave bands, the quantity calculated is averaged over angles and frequencies per band in 
Evaluation Group>Global Evaluation by selecting Data>Table columns>Outer solutions and 
Data series operation>Transformation>Average.

Results and Discussion

The sound pressure scattered by the diffuser arrangements and their infinite baffles is 
shown in Figure 2 for θ0 = 0° and f = 1335 Hz. In this case, the plane waves propagating 
in the wells of the Schroeder diffuser are clearly visible. Moreover, it is seen that the planar 
wavefront that would result from a perfectly specular reflection is disrupted by the 
presence of the wells. This is especially true in front of the diffuser arrangements, where 
the wavefront tends to a cylindrical wave. It also appears that destructive interferences 
create directions with greatly reduced energy. Although this effect is present in the single 
diffuser, it is seen to be more prominent in the 5-unit arrangement.

s 1

Ir es⋅( ) ld
L


Ir ld
L


-----------------------------–=
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Figure 2: Scattered pressure for θ0 = 0° and f = 1335 Hz. Top left: single diffuser; Top right: 
5-unit arrangement; Bottom: infinite arrangement.

Further investigation of the scattered sound field can be made from the SPL polar 
responses of the single diffuser in Figure 3 and the 5-unit arrangement in Figure 4. They 
are evaluated in the far field at a distance r0 = 10 m, for θ0 = 30° and the six frequencies 
composing the 250 Hz octave band in this study. This type of plot could not be generated 
for the infinite arrangement as it requires to evaluate sound pressure on a surrounding 
semicircle. It can be observed that the primitive root diffuser does reduce the energy 
reflected in the specular direction as intended. The difference between the SPL in the 
specular direction and the maximum SPL lies between 1 dB and 4 dB for the single 
diffuser, with energy being distributed rather evenly across angles. For the 5-unit 
arrangement, the SPL difference goes from 4 dB to 9 dB between the specular and 
maximum directions. However, it is seen that the reflected energy is concentrated between 
15° and 45°, as the lobes exhibit large amplitudes for both peaks and dips in that region 
of the polar response. This confirms the idea that a periodic arrangement reinforces certain 
reflection and attenuation directions for a given diffuser.
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Figure 3: Polar response of the single diffuser for θ0 = 30° in the 250 Hz octave band.

Figure 4: Polar response of the 5-unit arrangement for θ0 = 30° in the 250 Hz octave band.
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The scattering coefficients of the three diffuser arrangements is shown in Figure 5. Despite 
the differences observed in their polar responses, it is seen that the single diffuser and the 
5-unit arrangement return similar values for all frequencies. This illustrates one of the 
shortcomings of the scattering coefficient: it only quantifies non-specularly reflected 
energy without any consideration of the energy distribution over angles. Two diffusers 
could therefore have the same scattering coefficient and yet behave very differently. 
Nevertheless, this coefficient still provides valuable information in a simple manner. The 
infinite arrangement also gives interesting results. In this case, the scattering coefficient 
takes much lower values especially at low frequencies. This is a sign that scattering is 
dominated by diffraction from the finite size effect at low frequencies, and the wells’ 
influence is only effective at mid and high frequencies.

Figure 5: Random incidence scattering coefficient of the diffuser arrangements.

Notes About the COMSOL Implementation

This model was studied with the Pressure Acoustics, Frequency Domain interface. 
Alternatively, the Pressure Acoustics, Boundary Elements interface could also be used and 
return accurate results, but with the drawback that solving time would be larger for this 
small 2D model.
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Application Library path: Acoustics_Module/Building_and_Room_Acoustics/
diffuser_schroeder_2d

Modeling Instructions

This section contains the modeling instructions for the Schroeder Diffuser in 2D model. 
They are followed by the Geometry Modeling Instructions section.

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Acoustics>Pressure Acoustics>Pressure Acoustics,

Frequency Domain (acpr).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select General Studies>Frequency Domain.

6 Click Done.

Start by importing the three geometry cases and the parameters needed for the study.

S I N G L E  D I F F U S E R

1 In the Model Builder window, click Component 1 (comp1).

2 In the Settings window for Component, type Single diffuser in the Label text field.
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G E O M E T R Y  1

1 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
diffuser_schroeder_2d_geom_sequence.mph.

3 In the Insert Sequence dialog box, click OK.

G E O M E T R Y  1

1 In the Model Builder window, under Single diffuser (comp1) click Geometry 1.

2 In the Geometry toolbar, click Build All.

A D D  C O M P O N E N T

Right-click Single diffuser (comp1)>Geometry 1 and choose Add Component>2D.

5 - U N I T  A R R A N G E M E N T

In the Settings window for Component, type 5-unit arrangement in the Label text field.

G E O M E T R Y  2

1 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
diffuser_schroeder_2d_geom_sequence.mph.

3 In the Insert Sequence dialog box, select Geometry 2 in the 
Select geometry sequence to insert list.

4 Click OK.

G E O M E T R Y  2

1 In the Model Builder window, under 5-unit arrangement (comp2) click Geometry 2.

2 In the Geometry toolbar, click Build All.

A D D  C O M P O N E N T

Right-click 5-unit arrangement (comp2)>Geometry 2 and choose Add Component>2D.

I N F I N I T E  A R R A N G E M E N T

In the Settings window for Component, type Infinite arrangement in the Label text 
field.

G E O M E T R Y  3

1 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.
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2 Browse to the model’s Application Libraries folder and double-click the file 
diffuser_schroeder_2d_geom_sequence.mph.

3 In the Insert Sequence dialog box, select Geometry 3 in the 
Select geometry sequence to insert list.

4 Click OK.

G E O M E T R Y  3

1 In the Model Builder window, under Infinite arrangement (comp3) click Geometry 3.

2 In the Geometry toolbar, click Build All.

M A T E R I A L S

In the Home toolbar, click Windows and choose Add Material from Library.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-in>Air.

3 Click the right end of the Add to Component split button in the window toolbar.

4 From the menu, choose Single diffuser (comp1).

5 Click 5-unit arrangement (comp2) in the window toolbar.

6 Click Infinite arrangement (comp3) in the window toolbar.

7 In the Home toolbar, click Add Material to close the Add Material window.

G L O B A L  D E F I N I T I O N S

Parameters 1 - Geometry
In the Settings window for Parameters, type Parameters 1 - Geometry in the Label text 
field.

Parameters 2 - Physics
1 In the Home toolbar, click Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Parameters 2 - Physics in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
diffuser_schroeder_2d_parameters_physics.txt.
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Proceed with setting up the physics and local variables. The incident plane wave is defined 
manually in order to include the specular reflection from the infinite baffle in the 
Background Pressure Field. This allows the solver to only compute the influence of the 
diffuser on the sound field.

D E F I N I T I O N S  ( C O M P 1 )

In the Model Builder window, under Single diffuser (comp1) click Definitions.

Integration 1 (intop1)
1 In the Definitions toolbar, click Nonlocal Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Select Boundary 29 only.

Variables 1
1 Right-click Definitions and choose Variables.

2 In the Settings window for Variables, locate the Variables section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
diffuser_schroeder_2d_variables_single.txt.

P R E S S U R E  A C O U S T I C S ,  F R E Q U E N C Y  D O M A I N  ( A C P R )

Background Pressure Field 1
1 In the Model Builder window, expand the Single diffuser (comp1)>Pressure Acoustics,

Frequency Domain (acpr) node.

2 Right-click Pressure Acoustics, Frequency Domain (acpr) and choose 
Background Pressure Field.

3 Select Domain 1 only.

4 In the Settings window for Background Pressure Field, locate the 
Background Pressure Field section.

5 From the Pressure field type list, choose User defined.

6 In the pb text field, type p_inc+p_inf.

Perfectly Matched Boundary 1
1 In the Physics toolbar, click Boundaries and choose Perfectly Matched Boundary.

2 Select Boundaries 27 and 28 only.
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Exterior Field Calculation 1
1 In the Physics toolbar, click Boundaries and choose Exterior Field Calculation.

2 Select Boundaries 27 and 28 only.

3 In the Settings window for Exterior Field Calculation, locate the Exterior Field Calculation 
section.

4 From the Condition in the y = y0 plane list, choose Symmetric/

Infinite sound hard boundary.

Generate the mesh using the Physics-controlled mesh functionality. The frequency 
controlling the maximum element size is per default taken From study. Set the desired 
Frequencies in the study step. In general, 5 to 6 second-order elements per wavelength are 
needed to resolve the waves. For more details, see Meshing (Resolving the Waves) in the 
Acoustics Module User’s Guide. In this model we use the default Automatic option, which 
gives 5 elements per wavelength.

S T U D Y  1

Parametric Sweep
1 In the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

Step 1: Frequency Domain
1 In the Model Builder window, click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type 10^{range(log10(fL[1/Hz])+df_log/2,df_log,
log10(fU[1/Hz])-df_log/2)}.

4 Click to expand the Study Extensions section. Select the Auxiliary sweep check box.

5 Click Add.

Parameter name Parameter value list Parameter unit

n (Band number) range(0,1,5)
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6 In the table, enter the following settings:

M E S H  1

In the Model Builder window, under Single diffuser (comp1) right-click Mesh 1 and choose 
Build All.

Set up the the physics and generate the mesh in a similar fashion for the second component 
with five diffuser units.

5 - U N I T  A R R A N G E M E N T  ( C O M P 2 )

In the Model Builder window, click 5-unit arrangement (comp2).

A D D  P H Y S I C S

1 In the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select Acoustics>Pressure Acoustics>Pressure Acoustics,

Frequency Domain (acpr).

4 Click Add to 5-unit Arrangement in the window toolbar.

5 In the Home toolbar, click Add Physics to close the Add Physics window.

D E F I N I T I O N S  ( C O M P 2 )

Integration 2 (intop2)
1 In the Definitions toolbar, click Nonlocal Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Select Boundary 125 only.

Variables 2
1 In the Model Builder window, right-click Definitions and choose Variables.

2 In the Settings window for Variables, locate the Variables section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
diffuser_schroeder_2d_variables_5unit.txt.

Parameter name Parameter value list Parameter unit

theta0 (Incidence polar angle 
from normal direction)

range(-80,10,80) deg
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P R E S S U R E  A C O U S T I C S ,  F R E Q U E N C Y  D O M A I N  2  ( A C P R 2 )

In the Model Builder window, under 5-unit arrangement (comp2) click Pressure Acoustics,

Frequency Domain 2 (acpr2).

Background Pressure Field 1
1 In the Physics toolbar, click Domains and choose Background Pressure Field.

2 Select Domain 1 only.

3 In the Settings window for Background Pressure Field, locate the 
Background Pressure Field section.

4 From the Pressure field type list, choose User defined.

5 In the pb text field, type p_inc+p_inf.

Perfectly Matched Boundary 1
1 In the Physics toolbar, click Boundaries and choose Perfectly Matched Boundary.

2 Select Boundaries 123 and 124 only.

Exterior Field Calculation 1
1 In the Physics toolbar, click Boundaries and choose Exterior Field Calculation.

2 Select Boundaries 123 and 124 only.

3 In the Settings window for Exterior Field Calculation, locate the Exterior Field Calculation 
section.

4 From the Condition in the y = y0 plane list, choose Symmetric/

Infinite sound hard boundary.

M E S H  2

In the Model Builder window, under 5-unit arrangement (comp2) right-click Mesh 2 and 
choose Build All.

Define the third component with a periodic condition to model an infinite arrangement 
of diffusers. As a consequence, the sound pressure in the exterior field cannot be evaluated 
on a circular arc in this case; the calculation of the energy reflected in the specular direction 
is thus based on sound intensity.

I N F I N I T E  A R R A N G E M E N T  ( C O M P 3 )

In the Model Builder window, click Infinite arrangement (comp3).

A D D  P H Y S I C S

1 In the Physics toolbar, click Add Physics to open the Add Physics window.
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2 Go to the Add Physics window.

3 In the tree, select Acoustics>Pressure Acoustics>Pressure Acoustics,

Frequency Domain (acpr).

4 Click Add to Infinite Arrangement in the window toolbar.

5 In the Physics toolbar, click Add Physics to close the Add Physics window.

D E F I N I T I O N S  ( C O M P 3 )

Integration 3 (intop3)
1 In the Definitions toolbar, click Nonlocal Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Select Boundary 3 only.

Variables 3
1 In the Model Builder window, right-click Definitions and choose Variables.

2 In the Settings window for Variables, locate the Variables section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
diffuser_schroeder_2d_variables_infinite.txt.

P R E S S U R E  A C O U S T I C S ,  F R E Q U E N C Y  D O M A I N  3  ( A C P R 3 )

In the Model Builder window, under Infinite arrangement (comp3) click Pressure Acoustics,

Frequency Domain 3 (acpr3).

Background Pressure Field 1
1 In the Physics toolbar, click Domains and choose Background Pressure Field.

2 Select Domain 1 only.

3 In the Settings window for Background Pressure Field, locate the 
Background Pressure Field section.

4 In the p0 text field, type 1.

5 In the c text field, type c0.

6 Specify the ek vector as

sin(theta0) x

-cos(theta0) y
16 |  S C H R O E D E R  D I F F U S E R  I N  2 D



7 Select the Calculate background and scattered field intensity check box.

8 In the ρ text field, type rho0.

Perfectly Matched Boundary 1
1 In the Physics toolbar, click Boundaries and choose Perfectly Matched Boundary.

2 Select Boundary 3 only.

3 In the Settings window for Perfectly Matched Boundary, locate the Geometry section.

4 From the Attenuation direction list, choose Normal.

Periodic Condition 1
1 In the Physics toolbar, click Boundaries and choose Periodic Condition.

2 Select Boundaries 1 and 28 only.

3 In the Settings window for Periodic Condition, locate the Periodicity Settings section.

4 From the Type of periodicity list, choose Floquet periodicity.

5 Specify the kF vector as

M E S H  3

In the Model Builder window, under Infinite arrangement (comp3) right-click Mesh 3 and 
choose Build All.

R E S U L T S

1 In the Model Builder window, click Results.

2 In the Settings window for Results, locate the Update of Results section.

3 Select the Only plot when requested check box.

Proceed with solving the study. Generate the default plots for Component 1 only so as to 
avoid duplicate plot groups.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Physics and Variables Selection 
section.

sin(theta0)*acpr3.k x

-cos(theta0)*acpr3.k y
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3 In the table, enter the following settings:

4 Click to expand the Mesh Selection section. In the table, enter the following settings:

5 In the Study toolbar, click Show Default Plots.

6 In the Model Builder window, click Study 1.

7 In the Settings window for Study, locate the Study Settings section.

8 Clear the Generate default plots check box.

9 In the Model Builder window, click Step 1: Frequency Domain.

10 In the Settings window for Frequency Domain, locate the Physics and Variables Selection 
section.

11 In the table, enter the following settings:

12 Locate the Mesh Selection section. In the table, enter the following settings:

13 In the Study toolbar, click Compute.

Before investigating the results, remove the circular arcs from the datasets. They only serve 
a purpose for calculating integrals and do not need to be shown in the result plots.

Physics interface Solve for Equation form

Pressure Acoustics, Frequency 
Domain 2 (acpr2)

Automatic (Frequency domain)

Pressure Acoustics, Frequency 
Domain 3 (acpr3)

Automatic (Frequency domain)

Component Mesh

5-unit arrangement No mesh

Infinite arrangement No mesh

Physics interface Solve for Equation form

Pressure Acoustics, Frequency 
Domain 2 (acpr2)

√ Automatic (Frequency domain)

Pressure Acoustics, Frequency 
Domain 3 (acpr3)

√ Automatic (Frequency domain)

Component Mesh

5-unit arrangement Mesh 2

Infinite arrangement Mesh 3
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R E S U L T S

Study 1/Parametric Solutions 1 (4) - Single diffuser
1 In the Model Builder window, expand the Results>Datasets node, then click Study 1/

Parametric Solutions 1 (4) (sol2).

2 In the Settings window for Solution, type Study 1/Parametric Solutions 1 (4) - 
Single diffuser in the Label text field.

Selection
1 In the Results toolbar, click Attributes and choose Selection.

2 In the Settings window for Selection, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domain 1 only.

Study 1/Parametric Solutions 1 (5) - 5-unit arrangement
1 In the Model Builder window, under Results>Datasets click Study 1/

Parametric Solutions 1 (5) (sol2).

2 In the Settings window for Solution, type Study 1/Parametric Solutions 1 (5) - 
5-unit arrangement in the Label text field.

Selection
1 Right-click Study 1/Parametric Solutions 1 (5) - 5-unit arrangement and choose Selection.

2 In the Settings window for Selection, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domain 1 only.

Create an Array dataset to show multiple periods of the infinite arrangement of diffusers.

Study 1/Parametric Solutions 1 (6) - Infinite arrangement
1 In the Model Builder window, under Results>Datasets click Study 1/

Parametric Solutions 1 (sol2).

2 In the Settings window for Solution, type Study 1/Parametric Solutions 1 (6) - 
Infinite arrangement in the Label text field.

Array 2D - 5 periods of the infinite arrangement
1 In the Results toolbar, click More Datasets and choose Array 2D.

2 In the Settings window for Array 2D, locate the Data section.

3 From the Dataset list, choose Study 1/Parametric Solutions 1 (6) -

Infinite arrangement (sol2).
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4 In the Label text field, type Array 2D - 5 periods of the infinite arrangement.

5 Locate the Array Size section. In the X size text field, type 5.

6 Click to expand the Advanced section. Select the Floquet-Bloch periodicity check box.

7 Find the Wave vector subsection. In the X text field, type sin(theta0)*2*pi*freq/c0.

8 In the Y text field, type -cos(theta0)*2*pi*freq/c0.

Acoustic Pressure (acpr)
1 In the Model Builder window, under Results click Acoustic Pressure (acpr).

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Parameter value (n) list, choose 3.

4 From the Parameter value (freq (Hz),theta0 (deg)) list, choose 94: freq=1334.8 Hz,

theta0=0 deg.

Surface 1
1 In the Model Builder window, expand the Acoustic Pressure (acpr) node, then click 

Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type p_scat.

4 In the Acoustic Pressure (acpr) toolbar, click Plot.
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5 Click the Zoom Extents button in the Graphics toolbar.

Acoustic Pressure (acpr)
1 In the Model Builder window, click Acoustic Pressure (acpr).

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Dataset list, choose Study 1/Parametric Solutions 1 (5) - 5-

unit arrangement (sol2).

4 In the Acoustic Pressure (acpr) toolbar, click Plot.
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5 Click the Zoom Extents button in the Graphics toolbar.

6 From the Dataset list, choose Array 2D - 5 periods of the infinite arrangement.
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7 In the Acoustic Pressure (acpr) toolbar, click Plot.

Sound Pressure Level (acpr)
1 In the Model Builder window, click Sound Pressure Level (acpr).

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Parameter value (n) list, choose 3.

4 From the Parameter value (freq (Hz),theta0 (deg)) list, choose 94: freq=1334.8 Hz,

theta0=0 deg.

Surface 1
1 In the Model Builder window, expand the Sound Pressure Level (acpr) node, then click 

Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type Lp_scat.

4 In the Sound Pressure Level (acpr) toolbar, click Plot.

5 Click the Zoom Extents button in the Graphics toolbar.

Sound Pressure Level (acpr)
1 In the Model Builder window, click Sound Pressure Level (acpr).

2 In the Settings window for 2D Plot Group, locate the Data section.
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3 From the Dataset list, choose Study 1/Parametric Solutions 1 (5) - 5-

unit arrangement (sol2).

4 In the Sound Pressure Level (acpr) toolbar, click Plot.

5 From the Dataset list, choose Array 2D - 5 periods of the infinite arrangement.

6 In the Sound Pressure Level (acpr) toolbar, click Plot.

Exterior-Field Sound Pressure Level (acpr)
1 In the Model Builder window, click Exterior-Field Sound Pressure Level (acpr).

2 In the Settings window for Polar Plot Group, locate the Data section.

3 From the Parameter selection (n) list, choose From list.

4 In the Parameter values list, select 1.

5 From the Parameter selection (freq, theta0) list, choose Manual.

6 In the Parameter indices (1-102) text field, type range(12,17,102).

7 Locate the Axis section. Select the Symmetric angle range check box.

8 From the Zero angle list, choose Up.

9 Locate the Legend section. From the Position list, choose Manual.

10 In the x-position text field, type 0.5.

11 In the y-position text field, type 0.25.

Radiation Pattern 1
1 In the Model Builder window, expand the Exterior-Field Sound Pressure Level (acpr) node, 

then click Radiation Pattern 1.

2 In the Settings window for Radiation Pattern, locate the Expression section.

3 In the Expression text field, type Lp_ext.

4 Locate the Evaluation section. Find the Angles subsection. In the Number of angles text 
field, type 360.

5 From the Restriction list, choose Manual.

6 In the φ start text field, type -90.

7 In the φ range text field, type 180.

8 Find the Circle subsection. From the Circle list, choose Manual.

9 Find the Evaluation distance subsection. In the Radius text field, type r0.

10 Find the Reference direction subsection. In the x text field, type 0.

11 In the y text field, type 1.
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12 In the Exterior-Field Sound Pressure Level (acpr) toolbar, click Plot.

Exterior-Field Sound Pressure Level (acpr)
1 In the Model Builder window, click Exterior-Field Sound Pressure Level (acpr).

2 In the Settings window for Polar Plot Group, locate the Data section.

3 From the Dataset list, choose Study 1/Parametric Solutions 1 (5) - 5-

unit arrangement (sol2).
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4 In the Exterior-Field Sound Pressure Level (acpr) toolbar, click Plot.

Exterior-Field Pressure (acpr)
1 In the Model Builder window, click Exterior-Field Pressure (acpr).

2 In the Settings window for Polar Plot Group, locate the Data section.

3 From the Parameter selection (n) list, choose From list.

4 In the Parameter values list, select 1.

5 From the Parameter selection (freq, theta0) list, choose Manual.

6 In the Parameter indices (1-102) text field, type range(12,17,102).

7 Locate the Axis section. Select the Symmetric angle range check box.

8 From the Zero angle list, choose Up.

9 Locate the Legend section. From the Position list, choose Manual.

10 In the x-position text field, type 0.5.

11 In the y-position text field, type 0.25.

Radiation Pattern 1
1 In the Model Builder window, expand the Exterior-Field Pressure (acpr) node, then click 

Radiation Pattern 1.

2 In the Settings window for Radiation Pattern, locate the Expression section.
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3 In the Expression text field, type abs(p_scat_ext)^2.

4 Locate the Evaluation section. Find the Angles subsection. In the Number of angles text 
field, type 360.

5 From the Restriction list, choose Manual.

6 In the φ start text field, type -90.

7 In the φ range text field, type 180.

8 Find the Circle subsection. From the Circle list, choose Manual.

9 Find the Evaluation distance subsection. In the Radius text field, type r0.

10 Find the Reference direction subsection. In the x text field, type 0.

11 In the y text field, type 1.

12 In the Exterior-Field Pressure (acpr) toolbar, click Plot.

Exterior-Field Pressure (acpr)
1 In the Model Builder window, click Exterior-Field Pressure (acpr).

2 In the Settings window for Polar Plot Group, locate the Data section.

3 From the Dataset list, choose Study 1/Parametric Solutions 1 (5) - 5-

unit arrangement (sol2).

4 In the Exterior-Field Pressure (acpr) toolbar, click Plot.

Evaluation Group 1
1 In the Results toolbar, click Evaluation Group.

2 In the Settings window for Evaluation Group, locate the Data section.

3 From the Dataset list, choose Study 1/Parametric Solutions 1 (4) - Single diffuser (sol2).

4 Click to expand the Format section. From the Include parameters list, choose Off.

Global Evaluation 1
1 Right-click Evaluation Group 1 and choose Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Data section.

3 From the Table columns list, choose Outer solutions.

4 Locate the Expressions section. In the table, enter the following settings:

5 Locate the Data Series Operation section. From the Transformation list, choose Average.

Expression Unit Description

fC Hz Band center frequency

1-Pw_spec/Pw_tot 1
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6 In the Evaluation Group 1 toolbar, click Evaluate.

Evaluation Group 2
1 In the Model Builder window, under Results right-click Evaluation Group 1 and choose 

Duplicate.

2 In the Settings window for Evaluation Group, locate the Data section.

3 From the Dataset list, choose Study 1/Parametric Solutions 1 (5) - 5-

unit arrangement (sol2).

4 In the Evaluation Group 2 toolbar, click Evaluate.

Evaluation Group 3
1 Right-click Evaluation Group 2 and choose Duplicate.

2 In the Settings window for Evaluation Group, locate the Data section.

3 From the Dataset list, choose Study 1/Parametric Solutions 1 (6) -

Infinite arrangement (sol2).

Global Evaluation 1
1 In the Model Builder window, expand the Evaluation Group 3 node, then click 

Global Evaluation 1.

2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

4 In the Evaluation Group 3 toolbar, click Evaluate.

Scattering coefficients
1 In the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Scattering coefficients in the Label 
text field.

3 Locate the Data section. From the Dataset list, choose None.

4 Locate the Plot Settings section. Select the x-axis label check box.

5 In the associated text field, type Band center frequency (Hz).

6 Select the y-axis label check box.

7 In the associated text field, type Scattering coefficient.

8 Locate the Axis section. Select the Manual axis limits check box.

Expression Unit Description

1-I_spec/I_tot 1
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9 In the x minimum text field, type 125.

10 In the x maximum text field, type 4000.

11 In the y minimum text field, type 0.

12 Select the x-axis log scale check box.

Table Graph 1
1 Right-click Scattering coefficients and choose Table Graph.

2 In the Settings window for Table Graph, locate the Data section.

3 From the Source list, choose Evaluation group.

4 Click to expand the Legends section. Select the Show legends check box.

5 From the Legends list, choose Manual.

6 In the table, enter the following settings:

Table Graph 2
1 In the Model Builder window, right-click Scattering coefficients and choose Table Graph.

2 In the Settings window for Table Graph, locate the Data section.

3 From the Source list, choose Evaluation group.

4 From the Evaluation group list, choose Evaluation Group 2.

5 Locate the Legends section. Select the Show legends check box.

6 From the Legends list, choose Manual.

7 In the table, enter the following settings:

Table Graph 3
1 Right-click Scattering coefficients and choose Table Graph.

2 In the Settings window for Table Graph, locate the Data section.

3 From the Source list, choose Evaluation group.

4 From the Evaluation group list, choose Evaluation Group 3.

5 Locate the Legends section. Select the Show legends check box.

6 From the Legends list, choose Manual.

Legends

Single diffuser

Legends

5-unit arrangement
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7 In the table, enter the following settings:

8 In the Scattering coefficients toolbar, click Plot.

Geometry Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Blank Model.

G L O B A L  D E F I N I T I O N S

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

Legends

Infinite arrangement
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4 Browse to the model’s Application Libraries folder and double-click the file 
diffuser_schroeder_2d_geom_sequence_parameters.txt.

A D D  C O M P O N E N T

In the Home toolbar, click Add Component and choose 2D.

S I N G L E  D I F F U S E R

1 In the Model Builder window, click Component 1 (comp1).

2 In the Settings window for Component, type Single diffuser in the Label text field.

G E O M E T R Y  1

Rectangle 1 (r1)
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type W.

4 In the Height text field, type d1.

5 In the Width text field, type Lw.

6 Locate the Position section. In the x text field, type -L/2+Li.

7 In the y text field, type -d1.

Rectangle 2 (r2)
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type Lw.

4 In the Height text field, type d2.

5 Locate the Position section. In the x text field, type -L/2+2*Li+Lw.

6 In the y text field, type -d2.

Rectangle 3 (r3)
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type Lw.

4 In the Height text field, type d3.

5 Locate the Position section. In the x text field, type -L/2+3*Li+2*Lw.

6 In the y text field, type -d3.
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Rectangle 4 (r4)
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type Lw.

4 In the Height text field, type d4.

5 Locate the Position section. In the x text field, type -L/2+4*Li+3*Lw.

6 In the y text field, type -d4.

Rectangle 5 (r5)
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type Lw.

4 In the Height text field, type d5.

5 Locate the Position section. In the x text field, type -L/2+5*Li+4*Lw.

6 In the y text field, type -d5.

Rectangle 6 (r6)
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type Lw.

4 In the Height text field, type d6.

5 Locate the Position section. In the x text field, type -L/2+6*Li+5*Lw.

6 In the y text field, type -d6.

Rectangle 1 (r1), Rectangle 2 (r2), Rectangle 3 (r3), Rectangle 4 (r4), Rectangle 5 (r5), 
Rectangle 6 (r6)
1 In the Model Builder window, under Single diffuser (comp1)>Geometry 1, Ctrl-click to 

select Rectangle 1 (r1), Rectangle 2 (r2), Rectangle 3 (r3), Rectangle 4 (r4), 
Rectangle 5 (r5), and Rectangle 6 (r6).

2 Right-click and choose Group.

Wells
In the Settings window for Group, type Wells in the Label text field.

Circle 1 (c1)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Size and Shape section.
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3 In the Radius text field, type r_air.

4 In the Sector angle text field, type 180.

Union 1 (uni1)
1 In the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Click in the Graphics window and then press Ctrl+A to select all objects.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.

5 In the Geometry toolbar, click Build All.

6 Click the Zoom Extents button in the Graphics toolbar.

Circular Arc 1 (ca1)
1 In the Geometry toolbar, click More Primitives and choose Circular Arc.

2 In the Settings window for Circular Arc, locate the Radius section.

3 In the Radius text field, type r0.

4 Locate the Angles section. In the End angle text field, type 180.

5 In the Geometry toolbar, click Build All.
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A D D  C O M P O N E N T

In the Model Builder window, right-click Geometry 1 and choose Add Component>2D.

5 - U N I T  A R R A N G E M E N T

In the Settings window for Component, type 5-unit arrangement in the Label text field.

G E O M E T R Y  1

Wells
In the Model Builder window, under Single diffuser (comp1)>Geometry 1 right-click Wells 
and choose Copy.

G E O M E T R Y  2

In the Model Builder window, under 5-unit arrangement (comp2) right-click Geometry 2 and 
choose Paste Group.

Wells 1 to the left
1 In the Model Builder window, right-click Wells and choose Duplicate.

2 In the Model Builder window, click Wells 1.

3 In the Settings window for Group, type Wells 1 to the left in the Label text field.

Rectangle 7 (r7)
1 In the Model Builder window, click Rectangle 7 (r7).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type -3*L/2+Li.

Rectangle 8 (r8)
1 In the Model Builder window, click Rectangle 8 (r8).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type -3*L/2+2*Li+Lw.

Rectangle 9 (r9)
1 In the Model Builder window, click Rectangle 9 (r9).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type -3*L/2+3*Li+2*Lw.

Rectangle 10 (r10)
1 In the Model Builder window, click Rectangle 10 (r10).

2 In the Settings window for Rectangle, locate the Position section.
34 |  S C H R O E D E R  D I F F U S E R  I N  2 D



3 In the x text field, type -3*L/2+4*Li+3*Lw.

Rectangle 11 (r11)
1 In the Model Builder window, click Rectangle 11 (r11).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type -3*L/2+5*Li+4*Lw.

Rectangle 12 (r12)
1 In the Model Builder window, click Rectangle 12 (r12).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type -3*L/2+6*Li+5*Lw.

Wells 2 to the left
1 In the Model Builder window, right-click Wells and choose Duplicate.

2 In the Model Builder window, click Wells 1.

3 In the Settings window for Group, type Wells 2 to the left in the Label text field.

Rectangle 13 (r13)
1 In the Model Builder window, click Rectangle 13 (r13).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type -5*L/2+Li.

Rectangle 14 (r14)
1 In the Model Builder window, click Rectangle 14 (r14).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type -5*L/2+2*Li+Lw.

Rectangle 15 (r15)
1 In the Model Builder window, click Rectangle 15 (r15).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type -5*L/2+3*Li+2*Lw.

Rectangle 16 (r16)
1 In the Model Builder window, click Rectangle 16 (r16).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type -5*L/2+4*Li+3*Lw.

Rectangle 17 (r17)
1 In the Model Builder window, click Rectangle 17 (r17).
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2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type -5*L/2+5*Li+4*Lw.

Rectangle 18 (r18)
1 In the Model Builder window, click Rectangle 18 (r18).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type -5*L/2+6*Li+5*Lw.

Wells 1 to the right
1 In the Model Builder window, right-click Wells and choose Duplicate.

2 In the Model Builder window, click Wells 1.

3 In the Settings window for Group, type Wells 1 to the right in the Label text field.

Rectangle 19 (r19)
1 In the Model Builder window, click Rectangle 19 (r19).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type L/2+Li.

Rectangle 20 (r20)
1 In the Model Builder window, click Rectangle 20 (r20).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type L/2+2*Li+Lw.

Rectangle 21 (r21)
1 In the Model Builder window, click Rectangle 21 (r21).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type L/2+3*Li+2*Lw.

Rectangle 22 (r22)
1 In the Model Builder window, click Rectangle 22 (r22).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type L/2+4*Li+3*Lw.

Rectangle 23 (r23)
1 In the Model Builder window, click Rectangle 23 (r23).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type L/2+5*Li+4*Lw.
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Rectangle 24 (r24)
1 In the Model Builder window, click Rectangle 24 (r24).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type L/2+6*Li+5*Lw.

Wells 2 to the right
1 In the Model Builder window, right-click Wells and choose Duplicate.

2 In the Model Builder window, click Wells 1.

3 In the Settings window for Group, type Wells 2 to the right in the Label text field.

Rectangle 25 (r25)
1 In the Model Builder window, click Rectangle 25 (r25).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type 3*L/2+Li.

Rectangle 26 (r26)
1 In the Model Builder window, click Rectangle 26 (r26).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type 3*L/2+2*Li+Lw.

Rectangle 27 (r27)
1 In the Model Builder window, click Rectangle 27 (r27).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type 3*L/2+3*Li+2*Lw.

Rectangle 28 (r28)
1 In the Model Builder window, click Rectangle 28 (r28).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type 3*L/2+4*Li+3*Lw.

Rectangle 29 (r29)
1 In the Model Builder window, click Rectangle 29 (r29).

2 In the Settings window for Rectangle, locate the Position section.

3 In the x text field, type 3*L/2+5*Li+4*Lw.

Rectangle 30 (r30)
1 In the Model Builder window, click Rectangle 30 (r30).

2 In the Settings window for Rectangle, locate the Position section.
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3 In the x text field, type 3*L/2+6*Li+5*Lw.

Circle 1 (c1)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type 3*r_air.

4 In the Sector angle text field, type 180.

Union 1 (uni1)
1 In the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Click in the Graphics window and then press Ctrl+A to select all objects.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.

5 In the Geometry toolbar, click Build All.

6 Click the Zoom Extents button in the Graphics toolbar.

Circular Arc 1 (ca1)
1 In the Geometry toolbar, click More Primitives and choose Circular Arc.

2 In the Settings window for Circular Arc, locate the Radius section.
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3 In the Radius text field, type r0.

4 Locate the Angles section. In the End angle text field, type 180.

5 In the Geometry toolbar, click Build All.

A D D  C O M P O N E N T

In the Model Builder window, right-click Geometry 2 and choose Add Component>2D.

I N F I N I T E  A R R A N G E M E N T

In the Settings window for Component, type Infinite arrangement in the Label text 
field.

G E O M E T R Y  1

Wells
In the Model Builder window, under Single diffuser (comp1)>Geometry 1 right-click Wells 
and choose Copy.

G E O M E T R Y  3

In the Model Builder window, under Infinite arrangement (comp3) right-click Geometry 3 
and choose Paste Group.

Rectangle 7 (r7)
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type L.

4 In the Height text field, type Hair.

5 Locate the Position section. In the x text field, type -L/2.

Union 1 (uni1)
1 In the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Click in the Graphics window and then press Ctrl+A to select all objects.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.

5 In the Geometry toolbar, click Build All.
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6 Click the Zoom Extents button in the Graphics toolbar.
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